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Overview 

Stellar Phoenix Lotus Notes Recovery is a complete recovery solution for damaged Lotus Notes 
(NSF) files. Software repairs corrupted NSF files and restores all contents of a NSF file. An 
intensive scan of the NSF file extracts all the data files, repairs it and recovers to a new usable 
NSF file. 
After the recovery of NSF file the software shows content of NSF file as original. All folders that 
were existing in the original NSF file will be shown with their contents in the two-pane structure. 
This means folders are also recovered by the software. 

Key features: 

• Enables user to view messages headers 

• Recovers e-mails,attachments, calendar entries, contacts, To Do and journals from 

damaged NSF files 

• Recovered file will be saved as .nsf file on any (including network) disk visible by the host 

operating system 

• Show preview of e-mails, calendar entries, contacts, To Do and journals of NSF files 

• Supports Java Applets and OLE objects  

 
 
Limitations: 
 

• Stellar Phoenix Lotus Notes Recovery does not support encrypted NSF files (Lotus notes 

V 8.0 or higher) 

• Application only supports the recovery of Mail, Personal Journal and Personal Address 

Book templates 

• Supports only .nsf files created from default .ntf files. Customized .nsf files are not 

supported 

• Images in mail body are not shown in preview 

• No support of preview of Calendar and To Do in full version but the support is given in 

demo version. 
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Installation Procedure 
 
Before installing the software, ensure that your system meets the minimum system requirements: 

Minimum System Requirements

• Processor: Pentium Class 

• Operating System: Windows XP/2003/Vista/Window 7 /Window 8 

• Memory: Minimum 256 MB (512 MB recommended) 

• Hard Disk: 50 MB of free space 

• IBM Lotus Notes version: 6.x and 7.x  

• Internet Explorer: Version 5 or later 

 

To install the software: 

• Double-click StellarPhoenixLotusNotesRecovery.exe file to start the setup process. 

The Setup - Stellar Phoenix Lotus Notes Recovery dialog box opens. Click Next. 

• In the License Agreement screen, select I accept the agreement option. The Next 

button will be enabled. Click Next. 

• In the Select Additional Tasks screen, check the required check boxes. Click Next. 

• In the Select Destination Location screen, provide the path by using Browse button where 

the setup files will be stored. Click Next. 

• In the Start Menu Folder screen, provide the path by using Browse button where the 

program's shortcuts will be stored. Click Next. 

• In the Ready to Install screen, review the settings. Click Back to change settings. After 

confirming the settings, click Install. The Installing screen shows the installation process. 

• After completing the process, the Completing the Stellar Phoenix Lotus Notes Recovery 

Setup Wizard screen opens. Click Finish. 

Starting the Software 

To start the application, do one of the following: 

• Click Start | All Programs | Stellar Phoenix Lotus Notes Recovery, and then click 

Stellar Phoenix Lotus Notes Recovery. 

• Double-click the shortcut icon of Stellar Phoenix Lotus Notes Recovery from the 

desktop. 



• Click quick launch icon on the taskbar. 

 You can clear Launch Stellar Phoenix Lotus Notes Recovery check box to stop the automatic launch of the 
software. 
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How to Order? 

The software can be purchased by making payments online by using a credit card. Please visit 
http://www.stellarinfo.com/email-repair/lotus-notes/buy-now.php?Order for more information and 
to place an order. 
Alternatively, if the demo version is installed then on the Help menu, select Order Stellar 
Phoenix Lotus Notes Recovery. This will open the home page of Stellar Phoenix Lotus Notes 
Recovery from where you can purchase the software. You can also click Order Stellar Phoenix 

Lotus Notes Recovery on the toolbar. Order Stellar Phoenix Lotus Notes Recovery opens, 
click the Buy Stellar Phoenix Lotus Notes Recovery link to visit the home page from where you 
can purchase the software. 
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How to Register? 

If the software is downloaded from http://www.stellarinfo.com/email-repair/lotus-notes/buy-now.php?Order  (i.e., 
ESD version), for the full functionality, the product must be registered using Serial Number (received through email after 
purchasing the product). 

If the software is installed using the product installation CD (i.e., BOX version), hardware lock[ ] is mandatory 
for the functioning of the software that is available with the software kit. 
 
After purchasing the software, you will receive the serial number, which is required to register the 
software. The serial number will be verified during the registration process and if the serial 
number is valid then the software will be registered. 
The software can be registered in different ways. These are the methods by using which you can 
register the software: 
 
Registration Over internet
You should have the serial number, which is received after purchase of the software. On entering 
the serial number it is verified by license server and on verification the software will be registered. 
 
Manual Activation
You will need to generate a PHX_REG.txt file and mail the .txt file to support@stellarinfo.com. 
After verifying the serial number and purchase details of the software, the site key will be 
delivered to you at your email address. This site key is used to register the software manually. 
 
Using Email 
If the registration of the software by using Online Registration or Manual Activation is not 
successful then you can still register the software by using email. An email will be send to online-
register@stellarinfo.com either automatically or manually by the Stellar Phoenix - Electronic 
Software Registration wizard. The software will be registered automatically, when Internet 
connection is available on your computer. 
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Registration Over Internet? 

To register the software over Internet: 

• On the Activation menu, select Activate Stellar Phoenix Lotus Notes Recovery 
Online. Click Yes. 

• In the Welcome to Stellar Phoenix - Electronic Software Registration wizard, click Next. 
• Type the Serial number (received through email after purchasing the product) in the 

Serial number text box. Click Next. 
 

 
 

• The software would automatically communicate with license server and register the 
software. Click Finish to complete the registration process. 

 

You can generate the PHX_REG.txt file manually by starting the online activation. View manual activation topic to 
perform the process of generating PHX_REG.txt file. 
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Manual Activation? 

To register the software by using manual activation process: 

• On the Activation menu, click Activate Stellar Phoenix Lotus Notes Recovery 
Online. The Warning dialog box opens, click Yes. 

• In the Welcome to Stellar Phoenix - Electronic Software Registration wizard, click 

Cancel. 

• The Stellar Phoenix Lotus Notes Recovery dialog box opens, click Yes 

 

 
 
 

• In the Stellar Phoenix Lotus Notes Recovery - Manual Software Registration screen, 

type the serial number, which is received after purchase of the software, in the Enter 

Serial Number textbox. Click Next. 
 

 
 

• A PHX_REG.txt file will be created on desktop. Email the text file to the email 

support@stellarinfo.com address. Click Finished. 

• After verifying the purchase details, you will receive the site key, at your email address 

that is specified during purchase of the software, that is required to register the 

software by using manual activation. 
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• When you receive the site key, open Stellar Phoenix Lotus Notes Recovery, on the 

Activation menu, select Manual Registration. 

• In the Stellar Phoenix Lotus Notes Recovery box, type the site key, which is received 

after sending the PHX_REG.txt file. Click Validate to register the software. 
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Stellar Phoenix Update Wizard 
 
Stellar Phoenix Update Wizard keeps Stellar Phoenix Lotus Notes Recovery updated. Update 
option in application checks for the latest updates available online. Stellar Phoenix Update Wizard 
checks for latest minor and major version available online. Stellar Phoenix Update Wizard 
automatically installs the minor version, if available. However, if major version available then you 
need to purchase it. While updating the software, it’s recommended to close all the running 
programs. 

To start Stellar Phoenix Update Wizard: 

1. In the Stellar Phoenix Lotus Notes Recovery screen, Click Update Wizard  icon. the 
Stellar Phoenix Update Wizard window opens, click Next. The wizard will start searching 
for the latest updates and if it finds any new version, a window pops up indicating the 
availability. 

2. Click Next, the software will start downloading files from the server. When the process is 
complete, the software will upgrade to the latest version. 

Live Update may not happen due to following reasons: 

o Internet connection failure 
o Application is up to date and no new updates are available 

 

If major version is available, to upgrade the software you have to purchase it. 
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User Interface 

Stellar Phoenix Lotus Notes Recovery has a rich Graphical User Interface (GUI) with many 
features. Application has a two-pane structure. Main user interface is as shown below. 
 

 
 

When you start Stellar Phoenix Lotus Notes Recovery, a dialog box as shown below opens. You 
can search, select and save recovered NSF file by using dialog box. 
 

 
 

Select NSF File button allows you to select an NSF file, Find NSF File button allows you to find 
NSF files and Change Destination button allows you to save recovered NSF file at preferred 
location. Start button starts the recovering process, Help button opens the help manual of the 
Stellar Phoenix Lotus Notes Recovery software and Close button closes the dialog box. 
Stellar Phoenix Lotus Notes Recovery has a toolbar and menubar having many options. 

Select NSF File dialog box is also opened by selecting Open NSF File on the File menu  and by clicking the Open 
NSF File to Repair icon from toolbar. 
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Menubar 
 
Menubar of Stellar Phoenix Lotus Notes Recovery has these menus and items: 
 

Menu Items 

File 

o Open: Opens Stellar Phoenix Lotus Notes Recovery dialog 

box that allows you to search and select .pst files. 

o Save Log: Saves the log report to a text file (.txt) 
o Clear Log: Clears the log generated by Stellar Phoenix 

Lotus Notes Recovery's processes 
o Exit: Close the Stellar Phoenix Lotus Notes Recovery 

View 

o Log View: Opens the log window at the bottom that provides 

shows current processes information such as start time of 

process, name of folders that are recovered 

o Toolbar: Shows and hides the toolbar 

o Status Bar: Shows and hides the status bar 

Activation 

o Activate Stellar Phoenix Lotus Notes Recovery Online: 
Starts the process of activating Stellar Phoenix Lotus Notes 

Recovery by using Internet. 

o Manual Registration: Starts the process of manual 

activation of Stellar Phoenix Lotus Notes Recovery. 

 

Help 

o Help Topics: Opens help guide of Stellar Phoenix Lotus 

Notes Recovery 

o Order Stellar Phoenix Lotus Notes Recovery: Opens the 

Order - Stellar Phoenix Lotus Notes Recovery dialog box 

from where you visit the buy page of Stellar Phoenix Lotus 

Notes Recovery website. 

o Contact Support: Opens email client to send mail to 

Technical Support. 
o Knowledge Base: Opens the Stellar Information Systems 

Ltd.'s knowledge web site where you can find numerous 

number of knowledge base articles related to data recovery 

concepts. 
o Submit a Ticket: Allows you to submit a ticket in Stellar 

Information Systems Ltd.'s online support Web site such that 

your query can be solved effectively. 
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o Updates: Starts Stellar Phoenix Update Wizard, which 

provides new updates available for the software. 
o About Stellar Phoenix Lotus Notes Recovery: Provides 

general information and End User License Agreement 

(EULA) of the Stellar Phoenix Lotus Notes Recovery. 

 

 



 
 

Toolbar 
 
Stellar Phoenix Lotus Notes Recovery has a toolbar with these tools: 

• : This icon opens Stellar Phoenix Lotus Notes Recovery dialog box by using which 

you can select and find NSF files in your computer. 

• : This icon saves log report of Stellar Phoenix Lotus Notes Recovery's processes to 

a text file. 

• : Stops currently running process 

• : Opens help guide of Stellar Phoenix Lotus Notes Recovery. 

• : keeps Stellar Phoenix Lotus Notes Recovery updated. Click this icon to run the 

update wizard, which downloads and installs newly available updates for Stellar Phoenix 

Lotus Notes Recovery. 

• : Provides general information and End User License Agreement (EULA) of Stellar 

Phoenix Lotus Notes Recovery. 

• : Provides information regarding the purchase of Stellar Phoenix Lotus Notes 

Recovery. 

14 



15 

Features 

Stellar Phoenix Lotus Notes Recovery has many features incorporated in it. It has a very interactive 
user-interface and fast scanning process. It not only recovers e-mails, but also address book, 
calendar, notes, and tasks saved in Lotus Notes software. Along with all these features mails 
repaired by software can also be viewed before saving it. The main features of Stellar Phoenix       
Lotus Notes Recovery can be stated as follows: 
 
Preview NSF file 
 
Recovers E-mail, Calendar, Alarms 
 
Log Report 
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Preview 

Stellar Phoenix Lotus Notes Recovery software gives an option to preview the repaired file before 
finally saving it. Preview shows all the data including mails, Calendar,Contacts, To-Do list, and 
Personal Journal.  
 
Visit the 'Preview NSF File' section of this user manual,  to know more in detail. This section 
describes the procedure to preview the recovered file in detail. 



17 

 

Recovers E-mails and Personal Folders 

E-mail messages recovered in the Stellar Phoenix Lotus Notes Recovery contain all the mails 
and their content. Inbox, Draft, Sent, Follow Up, Junk Mail and Views of the Lotus Notes file are 
recovered. Stellar Phoenix Lotus Notes Recovery not only recovers e-mails but it also repairs 
Calendar, Contacts,To-Do list and Personal Journals saved by user.  All this recovered data can 
be previewed and saved by Stellar Phoenix Lotus Notes Recovery. 



18 

 

Log Report 

Stellar Phoenix Lotus Notes Recovery application saves a log report of the recovery process. 
 Log file helps user to examine the time taken in repair process, path of the saved database file 
etc. 
 
If another file is repaired then log report of that repair process is concatenated in the previous log 
report. New log is written below the previous log. This log report can be saved for future 
reference. 'Save Log Report' section of this user manual describes viewing and saving of log file 
in detail. 



 

Search NSF files 

You can search for NSF files by using Find NSF File functionality of Stellar Phoenix Lotus Notes 
Recovery. You can search NSF files in drives, folders and sub folders. However, you can select 
only one drive to search NSF files. 

To search NSF files in drives: 

• On the File menu, select Open or click  icon on the toolbar to open Stellar Phoenix 

Lotus Notes Recovery box. 

• In the Stellar Phoenix Lotus Notes Recovery box, click Find NSF File button. 

• In the Find NSF File dialog box, under Search Options box, click Look in listbox to select 

drive. Select the required drive, and then click Start. 

 
 

• In the Find NSF File dialog box, under Search Results box, all NSF files that are found in 

the selected drive will be shown. Click a file to select, and then click OK. 

 

 
 

You can click Clear List button to clear the result of search process and start a new search process. 

  

To search NSF files in folders and subfolders: 
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• On the File menu, select Open or click  icon on the toolbar to open Stellar Phoenix 

Lotus Notes Recovery box. 

• In the Stellar Phoenix Lotus Notes Recovery box, click Find NSF File button. 

• In the Find NSF File dialog box, click Search in folder button. In the Browse for Folder 

dialog box, select a folder and click Start. In addition, if you want to search subfolders in 

that folder, check Search Subfolders checkbox. 

 

 
 

• In the Find NSF File dialog box, under Search Results box, all NSF files that are found in 

the selected drive will be shown. Click a file to select, and then click OK. 
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Preview NSF file 

Before saving the recovered Lotus Notes Storage file, the corrupt file data can be previewed in 
the Stellar Phoenix Lotus Notes Recovery software. All the e-mails in Inbox, Sent, Drafts, Junk 
folders and personal information in Calendar, Alarms, etc. are shown as preview. 
 
To preview the recovered mail, follow these steps.  
 

• Open the NSF file in Stellar Phoenix Lotus Notes Recovery. 
 

• Click Start button to scan the file. NSF file is shown in a three pane view. 
 

 
 

• Left-pane shows all the mails and folders in the NSF file in a tree form. Click on any mail 
or folder to preview.   
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Recover NSF files 

If location of NSF file is known then you can directly specify the location and start recovering the 
NSF file. If you do not know the location then you can search the required NSF file by using the 
search functionality of Stellar Phoenix Lotus Notes Recovery. 

To recover NSF files: 

• In the Stellar Phoenix Lotus Notes Recovery screen, on the File menu select Open or 

click   icon to open the Stellar Phoenix Lotus Notes Recovery box, and then click 

Select NSF File.  If file location is not known then search NSF file in drives and folders 

and select the required NSF file. 

• In the Open dialog box, locate and select the NSF file that needs to be recovered and 

click Open. 

• Click Change Destination button to specify destination where the recovered NSF file 

should be saved. You cannot change the destination after starting the recovery process. 

Therefore, ensure that the location specified in the Choose Destination box is the location 

where you want to save the recovered file. 

• Click Start button to start scanning the selected NSF file. It may take minutes to hours to 

complete the scanning process depending on the size of the selected NSF file. You can 

stop the scanning process by clicking the Stop button. 
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• After completion of scanning process, the Stellar Phoenix Lotus Notes Recovery box 

opens showing the recovery process details Click OK.  

 

Recovered NSF file will be saved at specified location in the folder having name as 

Recovered_day_month_date_time. 
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Save Log Report 

You can save record of all processes performed in Stellar Phoenix Lotus Notes Recovery as log 
report. 

To view log report: 

On the View menu, select Log View. A window opens in the bottom that shows all the current 
processes of Stellar Phoenix Lotus Notes Recovery. 

To save log report: 

• On the File menu, select Save Log. 
• In the Save As dialog box, specify the location where log file should be saved. Click 

Save. 

To clear log report: 

• On the File menu, select Clear Log. 
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Copyright 

Stellar Phoenix Lotus Notes Recovery software, accompanied user manual and documentation 
are copyright of Stellar Information Systems Ltd., with all rights reserved. Under the copyright 
laws, this user manual cannot be reproduced in any form without the prior written permission of 
Stellar Information Systems Ltd. No Patent Liability is assumed, however, with respect to the use 
of the information contained herein. 

Copyright © 1995-2010 by Stellar Information Systems Ltd. INDIA 
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Disclaimer  

The Information contained in this manual, including but not limited to any product specifications, 

is subject to change without notice. 

STELLAR INFORMATION SYSTEMS LTD PROVIDES NO WARRANTY WITH REGARD TO 

THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN AND HEREBY 

EXPRESSLY DISCLAIMS ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR 

FITNESS FOR ANY PARTICULAR PURPOSE WITH REGARD TO ANY OF THE FOREGOING 

STELLAR INFORMATION SYSTEMS LTD ASSUMES NO LIABILITY FOR ANY DAMAGES 

INCURRED DIRECTLY OR INDIRECTLY FROM ANY TECHNICAL OR TYPOGRAPHICAL 

ERRORS OR OMISSIONS CONTAINED HEREIN OR FOR DISCREPANCIES BETWEEN THE 

PRODUCT AND THE MANUAL. IN NO EVENT SHALL STELLAR INFORMATION SYSTEMS 

LTD, BE LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL SPECIAL, OR EXEMPLARY 

DAMAGES, WHETHER BASED ON TORT, CONTRACT OR OTHERWISE, ARISING OUT OF 

OR IN CONNECTION WITH THIS MANUAL OR ANY OTHER INFORMATION CONTAINED 

HEREIN OR THE USE THEREOF. 
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License Agreement 

Stellar Phoenix Lotus Notes Recovery 

Copyright © 1995-2010 by Stellar Information Systems Ltd. INDIA 

www.stellarinfo.com

All rights reserved. 

All product names mentioned herein are the trademarks of their respective owners. 

This license applies to the standard-licensed version of Stellar Phoenix Lotus Notes Recovery. 

Your Agreement to this License 

You should carefully read the following terms and conditions before using, installing or distributing 

this software, unless you have a different license agreement signed by Stellar Information 

Systems Ltd. 

If you do not agree to all of the terms and conditions of this License then do not copy, install, 

distribute or use any copy of Stellar Phoenix Lotus Notes Recovery with which this License is 

included, you may return the complete package unused without requesting an activation key 

within 30 days after purchase for a full refund of your payment. 

The terms and conditions of this License describe the permitted use and users of each Licensed 

Copy of Stellar Phoenix Lotus Notes Recovery. For purposes of this License, if you have a valid 

single-user license, you have the right to use a single Licensed Copy of Stellar Phoenix Lotus 

Notes Recovery. If you or your organization has a valid multi-user license, then you or your 

organization has the right to use up to a number of Licensed Copies of Stellar Phoenix Lotus 

Notes Recovery equal to the number of copies indicated in the documents issued by Stellar when 

granting the license. 

Scope of License 

Each Licensed Copy of Stellar Phoenix Lotus Notes Recovery may either be used by a single 

person or used non-simultaneously by multiple people who use the software personally installed 

on a single workstation. This is not a concurrent use license. 

All rights of any kind in Stellar Phoenix Lotus Notes Recovery, which are not expressly granted in 

this license, are entirely and exclusively reserved to and by Stellar Information Systems Ltd. You 

may not rent, lease, modify, translate, reverse engineer, decompile, disassemble or create 

derivative works based on Stellar Phoenix Lotus Notes Recovery nor permit anyone else to do 

so. You may not make access to Stellar Phoenix Lotus Notes Recovery available to others in 

connection with a service bureau, application service provider or similar business nor permit 

anyone else to do so. 

http://www.stellarinfo.com/
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Warranty Disclaimers and Liability Limitations. 

Stellar Phoenix Lotus Notes Recovery and all accompanying software, files, data and materials 

are distributed and provided AS IS and with no warranties of any kind, whether expressed or 

implied. In particular, there is no warranty for the quality of data recovered. You acknowledge that 

good data processing procedure dictates that any program including Stellar Phoenix Lotus Notes 

Recovery must be thoroughly tested with non-critical data before there is any reliance on it and 

you hereby assume the entire risk of all use of the copies of Stellar Phoenix Lotus Notes 

Recovery covered by this License. This disclaimer of warranty constitutes an essential part of this 

License. 

In addition, in no event does Stellar authorize you or anyone else to use Stellar Phoenix Lotus 

Notes Recovery in applications or systems where its failure to perform can reasonably be 

expected to result in a significant physical injury or in loss of life. Any such use is entirely at your 

own risk and you agree to hold Stellar harmless from any and all claims or losses relating to such 

unauthorized use. 

General 

This License is the complete statement of the agreement between the parties on the subject 

matter and merges and supersedes all other or prior understandings, purchase orders, 

agreements and arrangements. This License shall be governed by the laws of the State of Delhi, 

India. Exclusive jurisdiction and venue for all matters relating to this License shall be in courts and 

for a located in the State of Delhi, India and you consent to such jurisdiction and venue. There are 

no third party beneficiaries of any promises, obligations or representations made by Stellar 

herein. Any waiver by Stellar of any violation of this License by you shall not constitute nor 

contribute to a waiver by Stellar of any other or future violation of the same provision or any other 

provision of this License. 

Copyright ©1995-2010 by Stellar Information Systems Ltd. All rights reserved. 
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Trademarks  

Stellar Phoenix Lotus Notes Recovery® is a registered trademark of Stellar Information Systems 

Ltd. 

Lotus Notes® is a registered trademarks of IBM corporation. 

Windows 2000 Server®, Windows XP®, Windows 2003®, Windows Vista®, MS Office and MS 

Outlook are registered trademarks of Microsoft® Corporation Inc. 

All other brands and product names are trademarks or registered trademarks of their respective 

companies. 

All Trademarks Acknowledged. 
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Technical Support 

Our Technical Support professionals will give solutions for all your queries related to Stellar 

Products. 

You can either Call Us or Go Online to our support section http://stellarinfo.com/support.php  
 

Support Helpline 

Monday to Friday [ 24 Hrs. a day ] 

USA (Tollfree- Pre Sales Queries)    +1-877-778-6087 

USA (Post Sales Queries)    +1-732-584-2700 

UK (Europe)    +44-203-026-5337 

Australia & Asia Pacific +61-280149899 

Netherlands Pre & Post Sales Support    +31-208-111-188 

Worldwide    +91-921-395-5509 

Skype Id    stellarsupport 

Email Orders    orders@stellarinfo.com

Online Help 

• Chat Live with an Online technician 
 

• Search in our extensive Knowledge Base 
 

• Submit Enquiry (If our Knowledge Base does not answer your question) 

http://stellarinfo.com/esupport/users/kb.php
mailto:orders@stellarinfo.com?subject=Purchase%20Order
http://stellarinfo.com/support/
http://www.stellarinfo.com/support/kb.php
http://www.stellarinfo.com/support/submit-enquiry.php


  
 

About Stellar  

Stellar Information Systems Ltd. is a trusted name in the field of Data Recovery and Data 

Protection Software for more than a decade. 

We provide the widest range of Data Recovery Products. Our range includes Data Recovery 

Software for almost all Operating Systems and File Systems. 

Product line: 

Data Recovery 

A widest range of data recovery software that helps you recover your valued data lost after 

accidental format, virus problems, software malfunction, file/directory deletion, or even sabotage!. 

More Info >>

File Recovery 

The most comprehensive range of file undelete and unerase software for Windows and MS office 

repair tools. More Info >>

Email Recovery 

A wide range of mail recovery, mail repair and mail conversion applications for MS Outlook, MS 

Outlook Express and MS Exchange useful in instances of data loss due to damages and 

corruption of Email. More Info >>

Data Protection 

A wide range of Prevent Data Loss, Data backup and Hard Drive Monitoring Applications to 

ensure complete data protection against hard drive crash. More Info >>

Data Sanitization 

Data cleanup and file eraser utility can delete selected folders, groups of files, entire logical 

drives, System Traces & Internet traces. Once the data have been removed using Stellar Wipe - 

Data File eraser utility, it is beyond recovery limits of any Data Recovery Software or utility. More 

Info >>

For more information about us, please visit www.stellarinfo.com
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FAQs 

1. What is Stellar Phoenix Lotus Notes Recovery? 
 

Stellar Phoenix Lotus Notes Recovery is a complete recovery solution for damaged Lotus 
Notes (NSF) files. Software repairs corrupted NSF files and restores all contents of a NSF 
file. An intensive scan of the NSF file extracts all the data files, repairs it and recovers to a 
new usable NSF file. 
After the recovery of NSF file the software shows content of NSF file as original. 

 
2. I have run the demo version of the software. Can I see the preview of my recovered 

mails, calendar, alarms, etc.?  
 

Yes, in demo version you can see the preview of all recovered items, but to save your 
recovered items you need to purchase the software. 

 
3. What is the process to install Stellar Phoenix Lotus Notes Recovery? 

 
Before beginning installation process, quit all other programs, including anti-virus program, 
as they might interfere with the installation process. Double-click 
StellarPhoenixLotusNotesRecovery.exe file to start the setup process. The Setup - 
Stellar Phoenix Lotus Notes Recovery dialog box opens. Follow the steps to complete 
installation.  

 
4. What is the process to remove the Stellar Phoenix Lotus Notes RecoveryTool? 

 
To remove the software, just open Add/Remove Programs in Control Panel Select 
Stellar Phoenix Lotus Notes Recovery from installed programs. Click Uninstall button. 
Follow the steps to uninstall the software. 

 
5. How much time Stellar Phoenix Lotus Notes Recovery will take to scan and repair 

the NSF file? 
 

The scanning and saving time totally depends upon the corruption level and size of the file. 
If the process is running that means that the software is still working. 
 

6. Is it necessary to buy the software to preview corrupt NSF file? 
 
No, you can download the demo version of the software for free to preview your corrupt 
NSF file. Scan the file to see the preview. 
 

7. How to preview corrupt NSF files? 
 

To recover NSF file, follow these steps. 
 

• Select the NSF file. 
• Click Start button to scan the file. 
• Preview of the recovered file is shown in the application.  
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